IT ESSENTIALS – Mail Merging E-Mails to the College Letterhead Using Word 2013 (ST161)

May 2015

Book online at: Royalholloway.ac.uk/it/training
Self-Study packs also available
Table of Contents

FOLDERS REQUIRED AND INTRODUCTION .................................................................................. 2
ACCESSING THE IT TRAINING EXERCISE FILES AND (Y) DRIVE FROM YOUR OWN PC/LAPTOP ................................................................. 3
GETTING SESSION FILES USING WINDOWS EXPLORER .......................................................... 4
UNDERSTANDING THE MAIL MERGE PROCESS ........................................................................ 5
OPENING OUTLOOK ..................................................................................................................... 6
OPENING THE DATA SOURCE ...................................................................................................... 7
MODIFYING THE DATA SOURCE ................................................................................................ 8
SETTING UP THE MAIN DOCUMENT (1) ...................................................................................... 9
SETTING UP THE MAIN DOCUMENT (2) .................................................................................... 10
SETTING UP THE MAIN DOCUMENT (3) .................................................................................... 11
SETTING UP THE MAIN DOCUMENT (4) .................................................................................... 12
SAVING THE MAIN DOCUMENT ................................................................................................ 13
DISPLAYING THE MAIL MERGE TASK PANE .......................................................................... 14
SPECIFYING THE TYPE OF MAIL MERGE .................................................................................. 15
SELECTING THE DATA SOURCE (1) ............................................................................................ 16
SELECTING THE DATA SOURCE (2) ............................................................................................ 17
ENTERING MERGE FIELDS INTO THE DOCUMENT ................................................................... 18
USING THE GREETING LINE MERGE FIELD (1) ...................................................................... 19
USING THE GREETING LINE MERGE FIELD (2) ...................................................................... 20
USING THE MORE ITEMS MERGE FIELDS ................................................................................. 21
PREVIEWING THE MERGED E-MAILS ......................................................................................... 22
SENDING THE MERGED E-MAILS .............................................................................................. 23
USING SELECTIVE TEXT WITHIN MAIL Merges ..................................................................... 24
DISPLAYING THE MAIL MERGE TASK PANE .......................................................................... 25
SPECIFYING THE TYPE OF MAIL MERGE .................................................................................. 26
SELECTING THE DATA SOURCE (1) ............................................................................................ 27
SELECTING THE DATA SOURCE (2) ............................................................................................ 28
SETTING UP FOR THE SELECTIVE TEXT .................................................................................. 29
APPLYING SELECTIVE TEXT TO THE E-MAILS (1) ................................................................. 30
APPLYING SELECTIVE TEXT TO THE E-MAILS (2) ................................................................. 31
PREVIEWING THE MERGED E-MAILS ......................................................................................... 32
SENDING THE MERGED E-MAILS .............................................................................................. 33
MAKING USE OF WORD’S STANDARD FIELD NAMES ............................................................. 34
EXITING FROM WORD ............................................................................................................... 35
SESSION EVALUATION .............................................................................................................. 36

These session notes are available in alternative formats on request. For further information please contact Chris Horton in Computer Centre Room 102 (01784 41 4025, c.horton@rhul.ac.uk)
FOLDERS REQUIRED AND INTRODUCTION

A. Folders Required
The folder required for this session is:

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST161 Mail Merging E-Mails to the College Letterhead</td>
<td>R:\CC\ST161 Mail Merging E-Mails to the College Letterhead</td>
</tr>
</tbody>
</table>

This contains the following files:
- College Letterhead for Mail Merge.docx
- E-mail letter.docx
- E-mail Data Doc.xlsx

The (R:) drive, from which this file can be accessed, is available on all Open Access PCs. This can also be mapped on your own computer; details are given on the next page.

B. Introduction
In this session you will learn how to use Word’s Mail Merge facility to produce personalised e-mails that display on the College Letterhead.

You will also learn how to use Mail Merge’s Selective Merge facility, which uses a condition that you have set up to enable one of two different lines of text to be inserted into a mail merged e-mail.

C. Starting Word 2013 on a PC Lab PC

Follow these steps:
1. Click on Start at the bottom-left of the screen.
   - Select Word 2013.
ACCESSING THE IT TRAINING EXERCISE FILES AND (Y) DRIVE FROM YOUR OWN PC/LAPTOP

In order to access the files required to complete many of the IT Training exercises you need to access the drive, referred to as the (R:) drive in the notes. These instructions give details on how to connect to this drive, for example from your home, along with details on how you can also set up access to your (Y:) drive. Important: If your PC already has an (R:) drive/(Y:) drive you will need to select a different letter in the following instructions.

Follow these steps:

Note: If using a Mac, instructions on setting up Campus Anywhere (VPN) can be found at: http://www.rhul.ac.uk/IT/CampusAnywhere/
Instructions on mapping to the (R:) drive and (Y:) drive can be found at: http://www.rhul.ac.uk/it/faq/itfaqs/mac/mapnetworkdrive.aspx

If working on Campus ensure that you are connected to CampusNet.

OR

1 If working off Campus ensure that you are connected to the Internet and that you have connected to Campus Anywhere (VPN).
   Note: To obtain instructions on how to set up Campus Anywhere (VPN) visit:
       http://www.rhul.ac.uk/IT/CampusAnywhere/

Display My Computer or Computer. To do this:
Press the Windows key at the right of the keyboard and with it still depressed press E on the keyboard.

2 OR

   Click on Start and then click on Computer at the right of the Start menu.

To map to the (R:) drive:
Click on Tools.

3 Select Map network drive to open the Map Network Drive dialogue box. Click on the drop-down arrow to the right of the Drive: panel and select R: (or any letter of your choice if that already has an entry, and so already allocated).

   In the Folder: panel enter the mapping for the (R:) which is:
   \\ourdata.rhul.ac.uk\teaching\PCLabs
   Ensure that the Reconnect at logon box displays a tick mark. If it does not, click within it so that it displays one.

   Click on [Finish] to complete the setting up. You should now be able to see the (R:) drive containing the IT Training files.

To map to your (Y:) drive:

6 You can map to your (Y:) drive as covered in steps 3, 4 & 5 but note the following:
   a) If your PC already has a (Y:) drive you will need to select a different letter in step 3.
   b) In step 4 the path that you must enter is: \mydata.rhul.ac.uk\home\.

   Note: When accessing these drives you may be prompted for your username and password.
   If this occurs you must prefix your username with cc\ For example, if your username is zhaa666 then you must enter cc\zhaa666

7 When finished close the My Computer dialogue box by clicking on its X Close button. If a My Computer window is still displaying also close it by clicking on its X Close button.
GETTING SESSION FILES USING WINDOWS EXPLORER

We will begin the session by using Windows Explorer to copy a folder containing the files we will be using from the CC folder on the (R:) drive on to our (Y:) drive.

Note: see page 3 for details of setting up the (R:) drive if you do not already have it mapped on your PC etc.

Follow these steps:

1. Before starting we need to copy the ST161 Mail Merging E-Mails to the College Letterhead folder that contains the files we will be using in today’s session onto our individual (Y:) drive.

To do this on an Open-Access PC, begin by clicking on the Start button.

2. Then click on Y Drive from the Start menu that displays to open Windows Explorer. Alternatively, press the Windows key at the right of the keyboard and with it still depressed press E on the keyboard.

If necessary scroll down in the left-hand panel to display the list of available drives.

3. Click on the (R:) drive in the list to select the drive and display its contents in the right-hand panel.

4. In the right-hand panel double-click on the CC folder.

5. In the right-hand panel locate the ST161 Mail Merging E-Mails to the College Letterhead folder.

This is the folder that contains the files we will be using in today’s session.

6. Right-click on the folder to obtain a short-cut menu.

Copy this folder to the Clipboard by clicking on Copy (see illustration below).

You now need to paste the folder on to your (Y:) drive:

7. In the left-hand panel click on the (Y:) drive in the list to select the drive and display its contents in the right-hand panel.

8. In the right-hand panel right-click on any blank area to display a short-cut menu.

Select Paste to paste the folder into your (Y:) drive.

9. Close Windows Explorer by clicking on the red X Close button at its top right-hand corner.
UNDERSTANDING THE MAIL MERGE PROCESS

Mail Merging is the process of combining a standard document, termed the Main Document, with a data file, termed the Data Source (e.g. an Excel spreadsheet), to produce a third document, the Form Document, which can be produced as either a printed or e-mailed document.

This process is frequently used to produce mailshots, where a standard, but personalised, letter or e-mail is sent to a number of different people.

Main Document

10th May 2015

Dear Ann
Welcome back to Royal Holloway!
Congratulations on progressing to your 2nd year.
The new term begins on Monday 23rd September.
Please remember that your fees need to be paid by the end of September.
Have a great year!

10th May 2015

Dear Ben
Welcome back to Royal Holloway!
Congratulations on progressing to your 3rd year.
The new term begins on Monday 23rd September.
Please remember that your fees need to be paid by the end of September.
Have a great year!

Data Source

<table>
<thead>
<tr>
<th>Name</th>
<th>Name</th>
<th>e-mail Address</th>
<th>Year</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ann</td>
<td>Nonymous</td>
<td><a href="mailto:summer.teaching@rhu.ac.uk">summer.teaching@rhu.ac.uk</a></td>
<td>2nd</td>
<td>poor</td>
</tr>
<tr>
<td>Ben</td>
<td>Nonymous</td>
<td><a href="mailto:summer.teaching@rhu.ac.uk">summer.teaching@rhu.ac.uk</a></td>
<td>3rd</td>
<td>unknown</td>
</tr>
<tr>
<td>Chris</td>
<td>Horton</td>
<td><a href="mailto:chortn@rhu.ac.uk">chortn@rhu.ac.uk</a></td>
<td>2nd</td>
<td>good</td>
</tr>
</tbody>
</table>

Mail Merge

Personalised Letters/e-mails

10th May 2015

Dear Chris
Welcome back to Royal Holloway!
Congratulations on progressing to your 3rd year.
The new term begins on Monday 23rd September.
Please remember that your fees need to be paid by the beginning of each term.
Have a great year!
OPENING OUTLOOK

As we will be producing our mail merged output as e-mails it is important that before starting we first ensure that Outlook is running.

Follow these steps:

1. To begin opening Outlook in a PC Lab, click on the Start button at the bottom-left of the Screen.
2. Then click on All Programs at the bottom of the menu that displays.
3. Click on Current Applications from the menu that displays.
4. Click on Microsoft Office 2013.
5. Then click on Outlook 2013.
6. Outlook will run through a series of setup dialogue boxes to enable you to access your e-mail account.
7. When prompted for your password enter it into the dialogue box that displays.
8. When the Finish button displays at the bottom right-hand corner of the setup dialogue box click on it to complete the setting up.
9. Outlook will then display and take several minutes to complete loading.
OPENING THE DATA SOURCE

Follow these steps:

1. We will begin by opening the Excel Data Source in order to add our e-mail address as one of the recipients, which will enable us to see that the mail merge process has worked correctly:

2. Click on the Start button at the left of the Task Bar to display the Start menu.

3. Click on Excel 2013.

4. Click on the File tab at the left of the Ribbon at the top-left of the screen. Click on Open to display the Open window.

5. Click on Computer below the Open heading. Click on Browse in the right-hand panel to display the Open dialogue box.

If necessary scroll down in the left-hand panel to display the list of available drives.

6. Click on your (Y:) drive in the list to select the drive and display its contents in the right-hand panel.

7. In the right-hand panel locate the ST161 Mail Merging E-mails to the College Letterhead folder, and then double-click on it to display its contents.

8. Click on the file you want to open, which in this case is: E-mail Data Doc.xlsx

9. Click on Open to open the spreadsheet.

The Data Source is the file containing the details (fields) for each of the personalised information that you wish to include in the merged e-mail, e.g. person’s name and their e-mail address.

In most cases an Excel spreadsheet is used as the Data Source, although other formats, e.g. an Access database or Word table can be used.
MODIFYING THE DATA SOURCE

We will now modify the Excel based Data Source so that it includes our own e-mail address. This will enable us, in this case, to know that the mail merged e-mails have been produced.

When producing your real mail merges you are advised to produce a test run first to both your College and private (if you have one) e-mail accounts. This will enable you to check that the Letterhead’s content appears as you want it.

Follow these steps:

1. Before starting ensure you have completed the previous page. We will now modify the Data Source to include our own details:
2. Click in cell A4 and then enter your first name.
3. Click in cell B4 and then enter your family name.
4. Click in cell C4 and enter your College e-mail address.
5. When finished click on cell A1 to reduce the possibility of a blank row being included in the Data Source.
6. Save the changes by clicking on the Save button in the Quick Access Toolbar at the top left of the window.
7. That completes the work we need to do on our Data Source, so close Excel by clicking on its X Close button at the top-right of its window.

Notes for using an Excel list to create your Data Source:
- The first row of the list in Excel must contain a descriptive heading for each column.
- The list must not contain any totally empty rows or columns within the list. This is because Excel determines the list’s boundary by an empty row/column.
- The List should be kept self-contained, preferably by placing it on a separate worksheet. If this is not possible ensure that the list has an empty column to the right (and left if applicable, and an empty row below (and above if applicable).
- It is recommended that you use only one worksheet per Excel file (workbook), and that all other worksheets are deleted. This will make it easier to select the Data Source within the Mail Merge process.
- Wherever possible use Word’s ‘expected’ column headings, as highlighted on page 34.
**SETTING UP THE MAIN DOCUMENT (1)**

The Main Document that we will be using for this session is a version of the College Letterhead that has been specifically produced to enable its use in Mail Merges.

We will first open this, and then enter the relevant Letterhead details, followed by the email’s text.

**Follow these steps:**

1. We will now open the College Letterhead in Word so that we can prepare it ready to send the mail merged e-mails.
2. Display Word by clicking on its button on the Task bar. Then click on the **File** tab at the left of the **Ribbon**.
3. Click on **Open** to display the **Open** window.
4. Click on **Computer** below the **Open** heading. Click on **Browse** in the right-hand panel to display the **Open** dialogue box.
5. If necessary scroll down in the **left-hand** panel to display the list of available drives.
6. Click on your (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
7. In the **right-hand** panel locate the **ST161 Mail Merging E-mails to the College Letterhead** folder, and then double-click on it to display its contents.
8. In the **right-hand** panel locate the **College Letterhead for Mail Merge.docx** file. Then select it by clicking on it.
9. Click on **Open** to open the document.
To begin using the Mail Merge to E-mail Letterhead you need to personalise it by entering your details into the appropriate areas.

Follow these steps:

Before beginning ensure you have completed the previous page.

1. We will now enter our details into the Letterhead:
   Double-click on the orange **Name** heading at the right of the Letterhead to select it.
   Then overtype this with your name.
   Double-click on the **Qualifications** heading below your name.
   Then overtype this with your qualifications.
   OR if you do not want this to appear press the **Backspace** button on the keyboard **twice** to remove the text and close up the line.

2. Click and drag across the **Job Title** heading to select it.
   Then overtype this with your job title.

3. Double-click on the **Department** heading below your job title.
   Then overtype this with your Department’s name.
   Click and drag across the **xxxxxx** at the right of the **phone number** below your Department’s name.
   Then overtype this with your phone extension number, remembering to include the 41, 44, or 67 prefix as appropriate.

4. Click and drag across the **xxxxxx** at the left of the **e-mail address** below your phone number.
   Then overtype this with the **name** part of your **e-mail address**.
   In this case the **Recipient Name** and **Recipient Address** headings at the left of the Letterhead are not needed. Therefore to remove them:
   Click and drag across the **Recipient Name** and three **Recipient Address lines** of text to select them.
   Press the **Delete** key on the keyboard.

5. Finally double click on the **Date** ‘holding title’.
   Then overtype it with an appropriate date in a format of your choice.

6. Save the changes by clicking on the **Save** button in the **Quick Access Toolbar** at the top left of the window.
SETTING UP THE MAIN DOCUMENT (3)

You now need to enter the e-mail’s text into the Letterhead. This can be done by either entering the text directly into it, or by copying the text from another Word Document. In this case we will open a Word document that contains some suitable text for our e-mail, and then copy that into our Letterhead. This Word document is another that is included in the ST161 Mail Merging E-mails to the College Letterhead folder.

Follow these steps:

1. Before beginning ensure you have completed the previous page.
2. We will now open the Word document containing the text for our e-mail:
3. Click on the File tab at the left of the Ribbon.
4. Click on Open to display the Open window.
5. Click on Computer below the Open heading.
6. Click on Browse in the right-hand panel to display the Open dialogue box.
7. Ensure that the ST161 Mail Merging E-mails to the College Letterhead folder is displaying in the right-hand panel.
8. Then double-click on it to display its contents.
9. In the right-hand panel locate the E-mail Letter.docx file. Then select it by clicking on it.
10. Click on Open to open the document.
Setting up the Main Document (4)

If you were planning to type in your letter’s content you can now click and drag across the text Replace this text with your own and then enter the text you want. However, in this case we will copy the text from the document we have just opened and then paste it into the Letterhead document.

Follow these steps:

1. Before beginning ensure you have completed the previous page. We will now Copy the text from the Word document and Paste it into our Letterhead.

To Copy the Text:
2. Click and drag across the document’s text, including the top blank line, to select it.
3. Ensure that the Home tab at the left of the Ribbon is selected.
4. Copy the text by clicking on the Copy button in the Clipboard group at the left of the Ribbon.

Return to the letterhead document by clicking on the Word button on the Task bar at the bottom of the screen, and then clicking on the College Letterhead for Mail Merge.docx option.

To Paste the text into the Letterhead:
5. Click and drag across the text: Replace this text with your own (below the date at the left of the page) to select it.
6. Ensure that the Home tab at the left of the Ribbon is selected.
7. Click on the Paste button in the Clipboard group at the left of the Ribbon.
8. The text from the E-mail Letter.docx document will be Pasted into the Letterhead.
   Note: Ensure that the text is still formatted using the Corbel font (the College brand font).

---

Welcome back to Royal Holloway!
Congratulations on progressing to your year.
The new term begins on Monday 21st September 2015, when we look forward to seeing you.
Have a great year!
SAVING THE MAIN DOCUMENT

Having completed our Main Document we will now save it with a different filename so that the Letterhead we previously saved with our details is preserved for future use.

Follow these steps:

1. Before beginning ensure you have completed the previous page. We will now save the completed Letterhead document with a different filename:
2. Click on the File tab at the left of the Ribbon.
3. Click on Save As to display the Save As Window.
4. Click on Computer below the Save As heading.
5. Click on Browse in the right-hand panel to display the Save As dialogue box.
6. Ensure that the ST161 Mail Merging E-mails to the College Letterhead folder is displaying in the right-hand panel.
7. In the File name: panel ensure that the existing filename is selected. Then overwrite it with a filename that identifies it as the modified version, in this case: College Letterhead with content.docx
8. Click on Save to save the Letterhead document with its new filename.
### Displaying the Mail Merge Task Pane

Once your Main Document has been produced you can then move on to starting the Mail Merge process. To do this you can use either the Ribbon or the Mail Merge Task Pane.

In this case we will concentrate on using the Mail Merge Task Pane, as it guides you step-by-step through the Mail Merge process.

#### Follow these steps:

1. We will now begin the Mail Merge process by displaying the **Mail Merge Task Pane**.
2. Click on the **Mailings** tab towards the centre of the Ribbon.
3. Click on **Start Mail Merge** in the **Start Mail Merge** group towards the left of the Ribbon.
4. Select **Step by Step Mail Merge Wizard** at the bottom of the list that displays.
5. The **Mail Merge** Task Pane displays on the right-hand side of the screen.
**SPECIFYING THE TYPE OF MAIL MERGE**

To begin the actual Mail Merge process you need to specify the type of output required, e.g. a printed letter or e-mail.

Follow these steps:

1. Before starting ensure that you have completed the previous page. We will now begin the Mail Merge process by specifying that we need to produce e-mails.
2. Ensure that the heading **Step 1 of 6** is displayed towards the bottom of the Task Pane. If it is not click on the **Previous:** link below the ‘Step’ heading enough times to display it.
3. Under the **Select document type** heading at the top of the Task Pane click on the **E-mail messages** option so that it displays a check mark.
4. Under the **Step 1 of 6** heading towards the bottom of the Task Pane click on the **Next: Starting document** link.
5. Click on the **Use the current document** option under the **Select starting document** heading so that it displays a check mark.
6. Click on the **Next: Select recipients** link towards the bottom of the Task Pane.
SELECTING THE DATA SOURCE (1)

We now need to select the Data Source that we wish to use, which is where Word obtains the personalised data that is added to each Mail Merged e-mail.

In this case we will be using the Excel spreadsheet we modified earlier.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
   We now need to specify the location of the Excel worksheet that we will be using for this Mail Merge:

2. At the top of the Task Pane click on the **Use an existing list** option under the **Select recipients** heading so that it displays a check mark.

3. Click on **Browse** located below the **Use an existing list** heading at the centre of the Task Pane to display the **Select Data Source** dialogue box.

4. If necessary scroll down in the **left hand** panel to display the list of available drives.

5. Click on the **(Y:)** drive in the list to select the drive and display its contents in the right hand panel.

   In the **right-hand** panel locate the **ST161 Mail Merging E-mails to the College Letterhead** folder.
   Then double-click on it to display its contents.

6. In the **right-hand** panel click on the file name you want to open, which in this case is: **E-mail Data Doc.xlsx**.

7. Click on **Open**.

8. Click on **Open**.
Selecting the Data Source (2)

Follow these steps:

1. Before starting ensure that you have completed the previous page.
2. The Select Table dialogue box displays prompting you to select which table (or worksheet) you wish to use from the file that you have just selected.
3. In this case there is only one table (worksheet) to select from, so click on OK to accept this and close the dialogue box.
4. The Mail Merge Recipients dialogue box displays.
5. This enables us to select which records in the current data source are to be included in the Merge operation.
6. As, in this case, we wish to include all of the records, we need to ensure that the check box to the left of the Last Name field for each row contains a tick mark.
7. An easy way to do this is to ensure that the check box between the Data Source and Last Name headings contains a tick mark.
8. When you have finished, click on OK to close the dialogue box and associate the Data Source to your mail merge document.
9. Click on the Next: Write your e-mail message link towards the bottom of the Task Pane to display the list of available merge fields.
ENTERING MERGE FIELDS INTO THE DOCUMENT

We now need to enter the Merge Fields into our Main Document to show Word where the individual data fields (e.g. first name) from our Data Source should appear in our completed e-mails.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
2. Word provides a number of options for entering Merge Fields into a document or e-mail, of which three are particularly useful:

   **Address block**
   Enables a complete address (compiled from the Address 1, Address 2 etc Merge Fields) to be inserted as a single Merge Field. This can be useful, for example, when needing to include a company address at the top of a business letter/e-mail.

   **Greeting line**
   Enables a salutation to be inserted easily, e.g. Dear John, or Dear Sir or Madam. As this option can substitute a name with Dear Sir or Madam (or other text) should the name not be in the Data Source, the situation where just Dear (and no name) is avoided.

   **More items**
   Enables individual Merge Fields to be inserted from a dialogue box. The Merge Fields are picked up from, and given the same name as, the headings you include within the Data Source (e.g. Excel spreadsheet).

3. **Note:** The remaining options are not applicable to the UK or require a 3rd party add-in.

![Mail Merge](image)
 USING THE GREETING LINE MERGE FIELD (1)

The Greeting Line Merge Field enables a salutation to be easily inserted into your merged document or e-mail. An advantage of using this option is that should the (e.g.) person’s name be omitted from the Data Source Word can insert alternative text, e.g. Sir or Madam, thus avoiding an embarrassing blank after the word Dear.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
2. Position the insertion point where you want the first Merge Field to be inserted.
3. In this case we will enter the recipient’s first name as the salutation, so position the insertion point so that it is one line below the Date on the left-hand side.
4. Click on the Greeting line link at the centre of the Task Pane to display the Insert Greeting Line dialogue box.
5. Click on the down-arrow to the right of the left-most text box below the Greeting line format: heading and select the option you wish to use.
6. In this case we will select the Dear option.
7. Note: If you wish to use an option that is not included, simply overtype the content of the text box with the text you wish to use, remembering to include a space at the end of it.
8. Click on the down-arrow to the right of the centre text box below the Greeting line format: heading and select the format for the name that you wish to use.
9. In this case we will enter the option to display the applicant’s first name by selecting Joshua, which is the 9th option down.
**Using the Greeting Line Merge Field (2)**

**Follow these steps:**

1. Before starting ensure that you have completed the previous page.

2. Click on the down-arrow to the right of the right-most text box below the **Greeting line format**: heading and select the punctuation option you wish to include at the end of the greeting.

3. In this case we will select *(none)*, so that no punctuation is included.

4. Finally, you can specify how you want the salutation to display when Word cannot find the name. Setting this prevents the salutation displaying just (e.g.) Dear when the name is missing from the Data Source.

5. To do this click on the down-arrow to the right of the text box below the **Greeting line for invalid recipient names**: heading.

6. Then select the option you wish to use, which in this case is the Dear Sir or Madam, option. **Note:** To use an option that is not included in the list, simply overtype the content of the text box with the text you wish to use.

7. If you want you can view how the salutation will appear in the mail merged documents or e-mails by clicking on the left and right arrows below the **Preview** heading.

8. When you have finished click on **OK** to close the dialogue box.

9. If necessary, enter a blank line between the salutation and next line of text by pressing **Enter** on the keyboard.
**USING THE MORE ITEMS MERGE FIELDS**

The More Items option enables you to insert individual Merge Fields into your document or e-mail from the Inset Merge Field dialogue box.

These Merge Fields have the same name as the headings used within the Data Source (e.g. Excel spreadsheet) that you are using.

---

**Follow these steps:**

1. We will now use the **Insert Merge Field** dialogue box to insert the student’s year of study into the text. To begin, locate the sentence: **Congratulations on progressing to your year.**

2. Then click between the text **your** and **year**, ensuring that the included spaces are either side of the insertion point.

3. Click on the **More items**, option at the centre of the Task Pane to display the **Insert Merge Field** dialogue box.

4. Ensure that the **Database Fields** option under the **Insert**: panel contains a check mark.

5. Under the **Fields**: heading, click on the field heading that you want to insert into your document, which in this case is: **Year**.

6. Click on **Insert** to insert the Merge Field. **Note**: When the **Insert Merge Field** dialogue box is displaying the insertion point cannot be repositioned within the document. As a result, only one Merge Field can be effectively inserted at a time.

7. When you have finished click on the X **Close** button to close the dialogue box.

8. The modified Letterhead now contains the text for our e-mails along with the two Merge Fields to enable them to be personalised.

9. If it is likely that you will need to reuse this Letterhead in the future it could be useful to save it now. This will prevent it having to be recreated in the future.

In this case we will save it.

Therefore click on the **Save** button in the **Quick Access Toolbar** at the top left of the screen.
PREVIEWING THE MERGED E-MAILS

Before actually sending the merged e-mails you can preview them to ensure they do not contain any errors.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
2. We can now complete the merge process, and so obtain the personalised messages to all of the records in our Data Source.
3. Click on the Next: Preview your e-mail messages link towards the bottom of the Task Pane.
4. Preview the individual messages by clicking on the Next (>>) or Previous (<<) buttons under the Preview your e-mail messages heading at the top of the Task Pane.
5. Notice that both the salutation and year changes for each e-mail.
6. When you have finished click on the Next: Complete the merge link towards the bottom of the Task Pane.

Mail Merge

Write your e-mail message

If you have not already done so, write your e-mail message now.

To add recipient information to your message, click a location in the message, and then click one of the items below:

- Address block...
- Greeting line...
- Greeting wizard...
- Electronic postage...
- Envelope...
- U/S Postal barcode (japan)...
- More items...

When you have finished writing your message, click Next. Then you can preview and personalize each recipient’s message.

Step 4 of 6

↓ Next: Preview your e-mail messages
← Previous: Select recipients

Step 5 of 6

↓ Next: Complete the merge
← Previous: Write your e-mail message
SENDING THE MERGED E-MAILS

Once you have completed your merged e-mails you can then send them. Do note however that once you click on the OK button they are sent immediately – there is no dialogue box that displays to warn you that you are about to send a quantity of e-mails!

Follow these steps:

1. Having completed the e-mail text and added the Merge Fields we can now send the personalised e-mails.
2. Click on the Electronic Mail link under the Merge heading on the Task Pane to display the Merge to E-mail dialogue box.
3. Ensure that the To: panel displays the correct Merge Field for the e-mail address.
4. In this case this is e-mail_Address (taken from the e-mail Address column heading in Excel).
5. In the Subject line: panel enter the text you wish to appear in the e-mail’s Subject panel. In this case, for example, Welcome Back to Royal Holloway
6. Ensure that the Mail format: panel displays HTML, as this is the most appropriate option to use.
7. Finally, if you wish you can select which messages are to be sent by modifying the Send records options. In this case we will select All so that all of the e-mails will be sent.
8. When you are ready click on OK to begin the send process.
   **Note: Doing this actually SENDS the e-mails – there is no warning dialogue box!**
   When you have finished close the document by clicking on the File tab and selecting Close.
9. If you now view Outlook you should see the mail merged e-mail addressed to you in your Inbox folder, and a copy of all the e-mails sent in your Sent Items folder.
**Using Selective Text within Mail Merges**

Word’s Selective Text facility enables Mail Merge to insert one of two different lines of text into the mail merged e-mail depending on whether or not a condition you specify is satisfied.

For example, for students with a good payment Status the text can offer for them to pay their fees termly, and for those with a poor (or unknown) Status it can state they need to pay at the start of the Academic Year.

To enable this the Data Source (Excel spreadsheet) that we are using (E-mail Data Doc.xlsx) includes a **Status** field that indicates good, unknown or poor.

**Follow these steps:**

To demonstrate the use of Selective Text we will now produce further merged e-mails that are based on the modified Letterhead document that we created in the previous sections. As this document already contains the Merge Codes, this will also show how you can work with a document that already contains these.

1. Before beginning ensure that Word is displaying.
2. **To re-open the Letterhead document we have been working on:**
   - In Word click on the **File** tab at the left of the **Ribbon**.
   - Click on **Open** to display the Open window.
3. Click on **Computer** below the **Open** heading.
   - Click on **Browse** in the right-hand panel to display the Open dialogue box.
4. If necessary scroll down in the left-hand panel to display the list of available drives.
5. Click on your (Y:) drive in the list to select the drive and display its contents in the right-hand panel.
6. In the **right-hand** panel locate the **ST161 Mail Merging E-mails to the College Letterhead** folder, and then double-click on it to display its contents.
7. Click on the file name you want to open, which in this case is: **College Letterhead with content.docx**
8. Click on **Open** to open the Letterhead.

When the Microsoft Word dialogue box displays stating that **Opening the document will run an SQL command**, in this case click on **No** to stop the command from running and close the dialogue box.

**Note:** This dialogue box displays because this Letterhead document has been previously linked to a Data Source.

If you were to select **Yes**, Word would link the Main Document to the original Data Source, enabling the original Mail Merges to be re-produced (unless that Data Source had been updated, in which case the resultant Mail Merge would reflect those changes).

In contrast, selecting **No** enables a different Data Source to be selected.
DISPLAYING THE MAIL MERGE TASK PANE

We can now begin the Mail Merge process, and so we will open the Mail Merge Task Pane to guides us step-by-step through the process.

Follow these steps:

1. To display the Mail Merge Task Pane:
2. Click on the Mailings tab towards the centre of the Ribbon.
3. Click on Start Mail Merge in the Start Mail Merge group towards the left of the Ribbon.
4. Select Step by Step Mail Merge Wizard at the bottom of the list that displays.
5. The Mail Merge Task Pane displays on the right-hand side of the screen.
ST161 – Mail Merging E-Mails to the College Letterhead using MS Word 2013

SPECIFYING THE TYPE OF MAIL MERGE

To begin the actual Mail Merge process you need to specify what type of output is required, e.g. a printed letter or e-mail.

Follow these steps:

1. Before starting ensure that you have completed the previous page. We will now begin the Mail Merge process by specifying that we need to produce e-mails.
2. Ensure that the heading **Step 1 of 6** is displayed towards the bottom of the Task Pane. If it is not click on the Previous: link below the ‘Step’ heading enough times to display it.
3. Under the **Select document type** heading at the top of the Task Pane click on the **E-mail messages** option so that it displays a check mark.
4. Under the **Step 1 of 6** heading towards the bottom of the Task Pane click on the **Next: Starting document** link.
5. Click on the **Use the current document** option under the **Select starting document** heading so that it displays a check mark.
6. Click on the **Next: Select recipients** link towards the bottom of the Task Pane.
SELECTING THE DATA SOURCE (1)

We now need to select the Data Source that we wish to use, which is where Word obtains the personalised data that is added to each Mail Merged e-mail.

In this case we will be using the Excel spreadsheet we modified earlier.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
2. We now need to specify the location of the Excel worksheet that we will be using for this Mail Merge:
3. At the top of the Task Pane click on the Use an existing list option under the Select recipients heading so that it displays a check mark.
4. Click on Browse located below the Use an existing list heading at the centre of the Task Pane to display the Select Data Source dialogue box.
5. If necessary scroll down in the left hand panel to display the list of available drives.
6. Click on the (Y:) drive in the list to select the drive and display its contents in the right hand panel.
7. In the right-hand panel locate the ST161 Mail Merging E-mails to the College Letterhead folder.
   Then double-click on it to display its contents.
8. In the right-hand panel click on the file name you want to open, which in this case is: E-mail Data Doc.xlsx.
9. Click on Open.
SELECTING THE DATA SOURCE (2)

Follow these steps:

1. Before starting ensure that you have completed the previous page.

2. The Select Table dialogue box displays prompting you to select which table (or worksheet) you wish to use from the file that you have just selected.

3. In this case there is only one table (worksheet) to select from, so click on OK to accept this and close the dialogue box.

4. The Mail Merge Recipients dialogue box displays.

5. This enables us to select which records in the current data source are to be included in the Merge operation.

6. As, in this case, we wish to include all of the records, we need to ensure that the check box to the left of the Last Name field for each row contains a tick mark.

7. An easy way to do this is to ensure that the check box between the Data Source and Last Name headings contains a tick mark.

8. When you have finished, click on OK to close the dialogue box and associate the data source to your mail merge document.

9. Click on the Next: Write your e-mail message link towards the bottom of the Task Pane to display the list of available merge fields.

Note: You would normally now need to enter the Merge Fields into your Main Document. However, in this case we do not need to do this because we are using a Main Document that has them entered already.
**SETTING UP FOR THE SELECTIVE TEXT**

We will now use the Selective Text facility to include text stating whether the student must pay their fees by the end of September or at the beginning of each term.

**Follow these steps:**

1. Before starting ensure that you have completed the previous page.
2. To begin using Selective Text we will add a partial sentence to the e-mail text. The Selective Text will then be added to this.
3. Click at the end of the sentence that finishes: **we look forward to seeing you.**
4. Enter the text that we will be using for this partial sentence: **Please remember that your fees need to be paid by**
5. Press the **Spacebar** on the keyboard to add a space at the end of the text.
6. Save the change by clicking on the **Save** button in the **Quick Access Toolbar** at the top left of the window.

---

10th May 2015

«GreetingLine»

Welcome back to Royal Holloway!

Congratulations on progressing to your «Year» year.

The new term begins on Monday 22nd September 2014, when we look forward to seeing you.

Please remember that your fees need to be paid by

Have a great year!
APPLYING SELECTIVE TEXT TO THE E-MAILS (1)

When using the Selective Text facility you need to first specify which Merge Field in the Data Source is to be used to decide which of the two text options will display in the document or e-mail.

You need to then enter the two different text options that are to display.

Follow these steps:

1. Before starting ensure that you have completed the previous page. We can now set up the Selective Text facility to enter the different text depending on the student’s status.
2. Begin by ensuring that the Mailings tab at the centre of the Ribbon is selected.
3. Now position the insertion point where you want the selective text to appear. In this case click at the end of the line of text you have just entered.
4. Click on the Rules button towards the centre of the Ribbon in the Write and Insert Fields group.
5. From the list that displays select If...Then...Else... to display the Insert Word Field: IF dialogue box.
6. Click on the down-arrow in the Field name: panel and select the field to which you wish this operation to apply.
7. In this case select: Status.
8. Then click on the down-arrow in the Comparison: panel and select the comparison criteria you wish to apply.
9. In this case select: Equal to.
APPLYING SELECTIVE TEXT TO THE E-MAILS (2)

Follow these steps:

1. Before starting ensure that you have completed the previous page.
   Click within the **Compare to:** panel to obtain an insertion point.
   Then enter the criteria which will result in your first text item being inserted into your document.
   In this case enter: **good** (as we want the text to apply to all students with a Status of good).

2. Click within the **Insert this text:** panel to obtain an insertion point.
   Then enter the text you wish to display for this text item.
   In this case enter: **the beginning of each term.**

   **Note:** This is the text that will be displayed when the **Compare to:** criteria is **true** i.e. has good in the Excel spreadsheet’s Status field.

3. Now click within the **Otherwise inset this text:** panel to obtain an insertion point.
   Then enter the text you wish to display for the second text item, which in this case is:
   **the end of September.**

   **Note:** This is the text that will be displayed when the **Compare to:** criteria is **not** true i.e. does not have good (in this case it is poor or unknown) in the Excel spreadsheet’s Status field.

4. Click on **OK** to close the **Insert Word Field: IF** dialogue box and return to your main document.

5. Save the changes by clicking on the **Save** button in the **Quick Access Toolbar** at the top left of the window.
PREVIEWING THE MERGED E-MAILS

Before actually sending the merged e-mails you can preview them to ensure they do not contain any errors.

Follow these steps:

1. Before starting ensure that you have completed the previous page.
2. We can now complete the merge process, and so obtain the personalised messages to all of the records in our Data Source.
3. Click on the Next: Write your e-mail message link towards the bottom of the Task Pane.
4. As we do not need to make any further changes, click on the Next: Preview your e-mail messages link towards the bottom of the Task Pane.
5. Preview the individual messages by clicking on the Next or Previous buttons under the Preview your e-mail messages heading at the top of the Task Pane.
6. As you do this notice the changes within each e-mail for the salutation, year and text stating when the fees need to be paid.
7. When you have finished click on the Next: Complete the merge link towards the bottom of the Task Pane.

Mail Merge

Select recipients
- Use an existing list
- Select from Outlook contacts
- Type a new list

Use an existing list
- Currently, your recipients are selected from:
  - [Sheet3] in E-mail Data Document
- Select a different list...
- Edit recipient list...

Mail Merge

Write your e-mail message
- If you have not already done so, write your e-mail messages now.
- To add recipient information to your message, click a location in the message, and then click one of the items below:
  - Address block...
  - Greeting line...
  - Greeting text...
- Electronic postage...
- Barcode...
- LPI: postal barcode (Japan)...
- More items...

Mail Merge

Preview your e-mail messages
- One of the merged messages is previewed here. To preview another message, click one of the following:
  - Previous: Preview recipient list...
  - Next: Preview recipient list...
- Make changes
  - You can also change your recipient list:
    - Edit recipient list...
    - Exclude this recipient

5. Preview the individual messages by clicking on the Next or Previous buttons under the Preview your e-mail messages heading at the top of the Task Pane.

6. As you do this notice the changes within each e-mail for the salutation, year and text stating when the fees need to be paid.

7. When you have finished click on the Next: Complete the merge link towards the bottom of the Task Pane.
**SENDING THE MERGED E-MAILS**

Once you have completed your merged e-mails you can then send them.
Do note however that once you click on the OK button they are sent immediately – there is no dialogue box that displays to warn you that you are about to send a quantity of e-mails!

**Follow these steps:**

1. Having completed the setting up we can now send the personalised e-mails.
2. Click on the Electronic Mail link under the Merge heading on the Task Pane to display the Merge to E-mail dialogue box.
3. Ensure that the To: panel displays the correct Merge Field for the e-mail address.
4. In the Subject line: panel enter the text you wish to appear in the e-mail’s Subject panel. In this case enter, for example, Welcome Back to Royal Holloway
5. Ensure that the Mail format: panel displays HTML, as this is the most appropriate option to use.
6. Finally, if you wish you can select which messages are to be sent by modifying the Send records options. In this case we will select All so that all of the e-mails will be sent.
7. When you are ready click on OK to begin the send process. **Note:** Doing this actually SENDS the e-mails – there is no warning dialogue box!
8. When you have finished close the document by clicking on the File tab and selecting Close.
9. If you now view Outlook you should see the mail merged e-mail addressed to you in your Inbox folder, and a copy of all the e-mails sent in your Sent Items folder.
MAKING USE OF WORD’S STANDARD FIELD NAMES

When creating a Data Source, e.g. Excel spreadsheet, for use in Mail Merge you are advised to select the headings (Merge Field names) that you use from the following list. This is especially useful when using the Address Block and Greeting Line facilities because the headings below are the ones that Word ‘expects’ to use. Therefore, by using these you avoid the situation where data is not incorporated into the merged output because Word does not recognise the heading(s) used.

<table>
<thead>
<tr>
<th>Heading to use (where possible):</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Job Title</td>
</tr>
<tr>
<td>Last Name</td>
<td>Department</td>
</tr>
<tr>
<td>Suffix</td>
<td>Business Phone</td>
</tr>
<tr>
<td>Company</td>
<td>Business Fax</td>
</tr>
<tr>
<td>Address 1</td>
<td>Home Phone</td>
</tr>
<tr>
<td>Address 2</td>
<td>Home Fax</td>
</tr>
<tr>
<td>Address 3</td>
<td>E-mail Address</td>
</tr>
<tr>
<td>City</td>
<td>Web Page</td>
</tr>
<tr>
<td>State</td>
<td>Spouse/Partner Courtesy Title</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Spouse/Partner First Name</td>
</tr>
<tr>
<td>Country or Region</td>
<td>Spouse/Partner Middle Name</td>
</tr>
<tr>
<td>Unique Identifier</td>
<td>Spouse/Partner Last Name</td>
</tr>
<tr>
<td>Courtesy Title</td>
<td>Spouse/Partner Nickname</td>
</tr>
<tr>
<td>Middle Name</td>
<td>Phonetic Guide for First Name</td>
</tr>
<tr>
<td>Nickname</td>
<td>Phonetic Guide for Last Name</td>
</tr>
</tbody>
</table>
EXITING FROM WORD

When you have finished working with Word and no longer need to have it available you should exit in the proper manner. This can be done in several ways which include using the menus and the Close button. If you exit Word without saving your work or naming the document, a message box will appear prompting you to do so.

Follow these steps:

1. Click on the X Close button at the top right of the window.
2. If the Microsoft Word dialogue box displays asking if you want to save changes to the document in this case click on [Save] to save the changes we have made.
3. This will close both our document and Word, which concludes the session for today.
SESSION EVALUATION

If you have completed this session as a taught session, we would welcome your feedback to help us to improve our training provision by completing a short online Session Evaluation.

To access the Evaluation from any PC Lab PC:

1. Click on the Start button to open the Start Menu.
2. Click on All Programs to cascade the Programs menu.
3. Click on Training to display the Training subfolder.
5. The short online Session Evaluation will display ready for you to complete. This should take no longer than a couple of minutes.